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Overview  

Remotely Possible/32 Windows 95 version is a 32-bit remote control communication software
package. Remotely Possible/32 supports Windows 95 and networking environments with 
backward compatibility for PCs running Remotely Possible 16 bit versions.

Remotely Possible/32 is ideal for:
n Customer Support
n Help Desk
n Telecommuters
n Home Office professionals
n Classroom Training
n Monitoring



Features  

Remotely Possible/32 contains a collection of programs that allow you to:
n Edit access codes to provide security
n Change user preferences
n Remotely control several PCs
n Transfer files among multiple PCs
n Establish an interactive chat session among multiple PCs
n Get context-sensitive online help for important topics and difficult 

problems

New Remotely Possible/32 highlights include:
n Easy Installation
n Simultaneous Local and Remote Printing
n Multi-tasking
n Full Compatibility with 16 Bit Windows
n Enhanced Performance
n Simultaneous Control of Multiple Protocols
n Multiple Levels of Security
n Auto Panning
n Host Confirm Connect



Improvements  

Since Remotely Possible/32 supports both Windows 95 and Windows NT technologies, users 
gain advantages to the following improvements:

n 50-60% performance boost over 16 bit applications
n 32 bit Multi-tasking application
n Multiple and simultaneous remote control, file transfer, and chat sessions
n Local host confirmation for access
n User definable logging
n Browse multiple networks
n New user interface
n Enhanced file transfer
n Enhanced remote control
n New systems management facilities
n Increase task-orientation capabilities.    For example, you can create an 

icon to automatically open a frequently-used document
n New multi-tasking ability
n Background and remote printing ability
n Quicker menuing system



Edit Access Codes           



Remote Control
Remote Control allows the remote user to remotely control your PC. Remote Control provides
the remote user with the ability to run your PC as if the user was sitting at your PC.    As a 
Viewer PC, you can start up Windows 95 on a Host PC and select a particular program or a 
file to execute.



Remote Control
In this example, Betty the Viewer PC is remotely controlling Barney the Host PC.    Betty has 
launched an MS Word application on Barney’s system.

In the other example, Betty is also the Viewer PC for the Host PC called Fred. In that 
example, the Viewer PC is starting up a Windows 95 program.



Remote Control
Remote Control allows a Windows PC running the Viewer application to operate a remote 
Windows PC running the Host application. The keyboards, screens, and mice on the two PCs 
act as one. Both keyboards and mice are active to allow complete control of the Host PC.

Remote Control gives you the ability to take over a remote PC running Windows. Keystrokes 
and mouse movements from the Viewer’s PC are sent to the remote Host PC. Screen 
information from the applications running on the Host is transmitted back to the Viewer and 
displayed on the Viewer's screen.

Several options are available for a remote control session. 
n Blank the Host screen
n Disable the Host's keyboard and mouse
n Disable the Host's wallpaper
n Disable the Viewer keyboard and mouse
n Exit to your local machine
n Switch between full control and monitor only

These options must be set prior to connecting. To change an option, disconnect, change the 
option and then reconnect.

New features for Remote Control include:
n Auto Panning
n Baton Passing



File Transfer
File Transfer is a powerful tool that lets you exchange files between two Windows PCs. The 
Viewer or Host may initiate File Transfer. The PC that initiates File Transfer is the master. 
The remote machine then becomes a slave and is referred to as the background machine.

By initiating File Transfer, you can send files to a remote PC, or you can receive files from a 
remote PC.    Before file transfer, select the directory and files that you want to send or 
receive on both PCs. You can specify special confirmation and filtering options to apply to the
file transfer process. To start the file transfer, select the file transfer button located at the 
bottom of the screen. During the file transfer process, you are updated with the transfer 
status of both the individual file in progress and the total files involved in the transfer.    New 
features for file transfer include:

n Create and Remove Directories
n Rename Files
n Delete Files
n Switch control to the remote
n Long filename support
n Drag and Drop file transfer



Chat Session
Chat is a program that displays a pair of interactive Windows on both the Host and Viewer 
PC monitors. One window is for input, and the other for output. With Chat, you can 
communicate to the remote user by using your keyboard and display.

Chat gives you the ability to have a two-way interactive communication session between the
Host and Viewer. This program gives you the ability to "chat" to the remote user, and also 
allows the remote user to activate Chat.

Chat options include Cut, Copy, Paste, and Undo. These functions use the Windows 
clipboard, and you use the standard Windows techniques for applying the Chat options.

New features for Chat include:
n Chat Notification Bell
n Chat Window pops to foreground



User Preferences
The User Preferences function allows you to enter basic setup and configuration options 
before you use the Remotely Possible/32 programs.    The User Preferences function 
provides controls and options for the following:

n Viewer Mode
n Host Mode
n TCP/IP (if included in product)
n Dial Modems (if included in product)
n Event Log
n General

The user can specify how the Viewer and Host are to behave during a remote control session
by setting options in the Viewer Mode and Host Mode sections.    In TCP/IP, Dial, IPX and 
NetBios you can select data transmission options for licensed protocols.    The Event Log 
specifies what session information you want to record.    Finally, in the General preferences a 
user can set global program parameters.
User Preferences are options that you want to set up and customize before you begin using 
your programs.



Connecting to a Remote
The Connect to a Remote function provides the basic connection to another PC. Connect to a
Remote also consists of the Address Book and the Browse function.

The Address Book allows you to easily define connection information required to connect to 
remote PCs for outgoing connections. The Address Book allows you to maintain unlimited 
addresses containing IP names and addresses, and login-ids of frequently called systems 
stored in the database.

The Browse function is able to detect other PCs running Remotely Possible eliminating the 
need to create an address book of other users and IP addresses.    The Browse function is an 
alternative to the Address Book.

Start a connection by selecting one of the icons located at the bottom of the Connect To 
Remote window.    You can select:

n Viewer Mode - Remote Control
n Host Mode - Remote Control
n File Transfer Mode
n Chat Session



Receive Files
This allows access to File Transfer. Will only let the remote user receive files from your PC.



Send Files
This allows access to File Transfer. Will only let the remote user send files to your PC.



Enable Callback
Will force Remotely Possible/32 to call back the Callback Address. Turn this option on when
you desire added security beyond the login name and password.



Local Confirmation
Enables the pop-up Security Box for the selected User Login. Before a connection is allowed, 
the Host PC must type in a password set under the security options to allow the user access.



User Name
This field shows the user selected from the list box. When you select OK the information in 
the fields below is saved under this user name.



 RP Login Name
This field contains the Remotely Possible/32 login name used in the Connect To Remote 
window, which the remote caller MUST use in order to connect to your PC.



RP Login Password
This field contains the Remotely Possible/32 password for the user. This field is used in the 
Connect To Remote window, and always echoes asterisks (*****) to protect the identity of 
the user password. If both the login name and password match then a connection is allowed.



Callback Address
Enter the network address to call back here. This network address is called when callback is 
on and the correct login name and password were received. 



Notes
This field is for information only. It may contain information about the remote user to help 
you manage this database.



Access List
This list box contains the names of the users configured to access your system.    



OK
Save the current entry.



Add
This button adds the current user to password database and clears input fields for adding 
new user.

To add a new user to the database press the Add button at the bottom of the window. This 
action saves the current information in the user information fields and clears all the input 
fields to their default values. Enter information for each user, and when done press the Add 
button to add another user or press OK to exit the database. 



Delete
This will remove the current selection from the password database.

To delete a user from the database select the user name from the Password Directory list 
box. Press the Delete button to delete the user from the database after you've confirmed 
the selection.
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Security  



Disable Local Confirmation For All Calls
Select this option to disable the local confirmation for all calls feature. When this feature is 
on local users are not called back.    The connection is completed on the initial call.



Require to Change Access Code
Select to enable/disable password protection for the Access Codes database. Enter an 
access code and press OK.    Confirm the access code you've just entered. Now each time 
you start Edit Access Codes, you must enter this password. Do not forget it.



Master Password
The master password provides or denies access to remote users.

You must enter the correct password to access the Password Editor



Password to Use
This box is activated to indicate that a remote user must log in.    The password entered here
is the master password which regulates access for remote users.



Remote Users Must Log In
You may globally disable all users calling in from requiring a login name and password by 
disabling the Users must login option. This effectively disables security and allows FULL 
access to your PC. This also disables all callbacks since user-ids are bypassed.

If the Remote users must log in box is checked, then to gain access, the remote user 
must login and match the correct master password as entered in this box.



Disable Callback for all Users
Select this option to disable the callback feature. When this feature is on remote users are 
not called back.    The connection is completed on the initial call.

Also notice there are two other security related items in the dialog box. These are global 
settings that should be set when absolutely necessary. 

The Disable callback for all users will override the callback enable setting for all users. 
When this option is selected Remotely Possible/32 will establish a connection with a caller 
without requiring any callback to take place even if the user access options have callback 
enabled.



Cancel
Press the Cancel button to close without saving the current user information.



Help
Context sensitive help is available in windows and in dialog boxes. You can also access the 
online help in standalone mode as a reference tool before using this application.



Change User Preferences IPX
Sorry, IPX support is not currently available.



Change User Preferences Netbios
Sorry, Netbios support is not currently available.



Change User Preferences Dial           

Click on an area to get more information.



Data Compression
Enables/Disables Remotely Possible’s built in data compression algorithm.    Data 
compression is active for both file transfer and remote control. Enabling this feature will 
improve performance for virtually all connections.    Leave this feature on even when using 
modem data compression, or sending compressed files.



Error Correction
Enables/Disables Remotely Possible’s built in error correction algorithm. It is HIGHLY 
recommended that you leave this setting ON!. Most communication ports are prone to 
overruns under heavy CPU loads (even 16550 ports). Leaving this feature on will correct any 
errors that occur due to any condition - including overruns.



Rings to answer on
Determines which ring the modem should automatically answer an incoming call on.



Select modem(s) for incoming calls
This list contains all installed TAPI devices on which an incoming call may be received.    You 
may select up to 2 lines for incoming calls.    A line is available for an incoming call if the box 
is checked.    If you need to change the settings for a particular modem, highlight the modem
and select the configure button.    Note: Support for communication server hardware 
is available, please contact your Avalan sales representative. (ex. Digiboard, etc.)



Configure Modem
Select configure to change the modem Communication Port, Port Speed, Flow Control and 
settings. 
When a modem is highlighted and the configure button is selected the Windows 95 TAPI 
properties screen is displayed.    Remotely Possible/32 interfaces directly with TAPI and 
supports all Windows 95 TAPI compliant devices.    This screen is also available by selecting 
Control Panel, Modems then Properties. Note: Remotely Possible requires Hardware 
Flow Control to be enabled.



Change User Preferences           

To change the user preferences for an area select the tab at the top of the Window.    If you 
change an option during a connection, or while waiting for a connection, you must reconnect
or wait for another connection for the new settings to take effect.



Change User Preferences Viewer           

Click on an area to get more information.



Auto Pan Mode On
Set by Viewer mode. Provides automatic screen movement by mouse on the Viewer PC. Use 
this feature to view information on a remote PC that has a larger screen size than your PC.

Example
A Viewer PC with a 640x480 screen resolution that views a Host PC with a 800x600 screen 
resolution, can pan towards the four sides of the Host PC to view any missing information 
that does not fit on the Viewer PC screen because of the screen size difference.



Start In Full Screen Mode
Starts the display of the Host PC in a full screen on the Viewer PC instead of in a window.



Redirect Host Printer Port
You can select which printer port on the Host PC to redirect to your printer attached to the 
Viewer PC.

None
This disables Host printer redirection.

LPT1-LPT4
Selects the printer port on the Host PC to redirect to your local printer attached to the 
Viewer PC.



To Viewer Printer Port
Select the printer on the Viewer PC that the redirected Host printout is to use



Simultaneous Printing on the Host
In addition to redirecting the printer port to the Viewer you may also request simultaneous 
printing on the Viewer and the redirected port on the Host PC.



Mouse Exits Remote Control
While the Viewer is actively controlling a Host PC you will notice the upper left corner of the 
Viewer screen contains a flashing region. This flashing region serves two purposes. It informs
the Viewer that the Host's screen is being displayed in remote control mode and also 
indicates the position on the screen to use to exit remote control using your mouse.

Clicking the right button on your mouse while the cursor is in the blinking region will 
immediately switch you to your local (Viewer) screen. This is a quick alternative to the 
keyboard method of pressing Ctrl-Shift-Esc. In the highly unlikely case your application 
requires a right mouse button click in this region hold down either the Control or Shift key, or
click either the left or middle button while clicking the right mouse button. This will transmit 
the right mouse button click information to the Host PC (along with the corresponding 
Control/Shift key or left/middle click information).

To disable this feature entirely disable the Mouse exits remote control check-box in the 
Setup Window. Changing this option during a connection has no effect until the next 
connection.



Blink During Remote Control
While the Viewer is actively controlling a Host PC you will notice the upper left corner of the 
Viewer screen contains a flashing region. To disable the blinking indicator disable the Blink 
during remote control check-box in the Setup Window. Note: Even though you have 
disabled this feature you may still exit remote control by clicking the right mouse button 
while positioned in this region. You must disable the Mouse exits remote control option 
to disable that feature.



Disable Host Wallpaper
Selecting this option will disable the displaying of the Host's wallpaper during a connection. 
This setting will speed up the remote control session when the Host is using a background 
wallpaper.



Don't Flash Host Screen
When first connecting to a Host in remote control mode the default behavior is to force all 
the applications to do a repaint. This results in a "flash" on the screen just before the 
applications begin to repaint. As the applications repaint the screen we capture all the 
Windows GDI calls and transmit these to the Viewer.



Use Host's Standard Cursor
By default the Viewer will always use the Host's cursors when remotely controlling a Host PC.
If you are on a laptop and have enabled a cursor enhancement program to enlarge your 
cursors you should disable this option. This will allow laptop users to keep using their 
modified cursors when controlling a desktop PC with standard Windows cursors. Changing 
this option during a connection has no effect until the next connection.
Since many of the Cursor Enhancement Programs on the market will modify the display 
driver line in the system.ini file they may not run properly if you install another program that
also modifies the display driver setting in system.ini. The solution is to first install the 
standard display driver using either of the Windows setup programs provided with Windows, 
next install Remotely Possible/Sockets and then install the Cursor Enhancement program 
last. This will insure that the Cursor Enhancement program can find it's video driver. 



Blank Host's Screen
Select this option if you want the Host screen blanked during a remote control session.



Disable Host's Keyboard
Select this option if you want the Host keyboard disabled during a remote control session.



Disable Host's Mouse
Select this option if you want the Host mouse disabled during a remote control session.



Disable Host's Remotely Possible Window
Select this option if you want the Host screen disabled during a remote control session.



Monitor Only
Monitor Only disables the Viewer keyboard and mouse during remote control. You may still 
use your mouse to return to your local machine by pressing the right button while the cursor
is in the upper left corner of the screen. You may also toggle this feature to switch from 
monitor only to full control and back (See Toggle monitor mode).



Toggle Monitor Mode
You may enable/disable monitor only mode on the fly during remote control.    When toggle 
Monitor Mode is on you can switch between monitor only and full remote control by 
simultaneously pressing the Shift key and the right mouse button. If you are in monitor 
only mode you will switch to full remote control. If you are in full remote control mode you 
will switch to monitor only mode.



Change User Preferences           

Click on an area to get more information.

    



Note
For all Host options - when the Host option is selected, it overrides the Viewer PC selection. If
the option is not selected, the Viewer PC makes the decision.



Enable Host Operation
Select this option to enable Host mode for remote control. This option requires the addition 
or removal of files from the registry, and requires your PC to be rebooted for the changes to 
take effect.



Hide Remotely Possible

This option will hide the Remotely Possible application the next time it is started.    Caution: 
The program remains hidden for all session types, therefore a user will not be able to see a 
File Transfer or Chat session either.    To disable this feature hold the Shift+Ctrl keys down 
while starting, then set to Don’t hide.



Disable Wallpaper
Selecting this option disables the displaying of the Host's wallpaper during a connection. 
This setting will speed up the remote control session when the Host is using a background 
wallpaper.



Viewer Can Monitor Only
In monitor only mode, your keystrokes and mouse movements are not sent to the remote 
system.    You have no control over the remote system.



Don't Blank Screen
Select this option if you do not want the Host screen blanked during a remote control 
session.



Use Method 1
Standard Method of screen blanking. If you experience problems, try alternative method.



Use Method 2
Alternative Method of screen blanking. If you experience problems, try standard method.



Change User Preferences           

Click on an area to get more information.



Enable Inactivity Timer
The Inactivity Timer will automatically disconnect the session after there is no activity for the
time specified. Changing this option during a connection has no effect until the next 
connection.



Data Compression
Enables/Disables Remotely Possible's built in data compression algorithm.    Data 
compression is active for both file transfer and remote control. We recommended that you 
disable this feature on connections residing on the same LAN. Data Compression will 
improve performance when using dial-up SLIP or PPP connections or routers. Data 
compression is always controlled by the PC that initiates the connection. 



Error Detection Correction
Enables/Disables Remotely Possible's built in error detection and correction protocol. We 
recommend that you disable Error Detection and Correction unless you suspect problems 
with your TCP/IP stack. This will increase the performance of Remotely Possible/32 for most 
TCP/IP connections. Error Detection and Correction are always controlled by the PC that 
initiates the connection.



Auto Reconnect
This feature is currently not implemented at this time.



Computer Name
This should be a unique name on your Network that Remotely Possible/32 uses to 
communicate with other PCs on your LAN. This name along with the IP address is displayed 
by Remotely Possible/32 when browsing the network. You should set this to your IP Host 
name.



Wait for Connection(s)
Determines the amount of time to wait to complete a connection.



Allow Incoming Calls
Allows your PC to listen for and accept incoming connections. If this is not checked you will 
not be able to accept incoming connections via TCP/IP.



Allow Multiple Incoming Connections
Selecting this button allows multiple incoming connections to a PC.



Event Log  

The Event Log is a date and time journal containing all the communication activities involved
in the Remotely Possible/32 sessions. The following example is a list of the types of 
information tracked during a normal communication session.



Change User Preferences           

Click on an area to get more information.



Enable Logging of Viewer
This option automatically allows Viewer logging during a connection.



Enable Logging of File Transfer
File transfer connections are noted in the log by a listing of files that are sent and received 
during the connection.



Enable Logging of Host
This option automatically allows Host logging during a connection.



Enable Logging of Chat
This option automatically enables logging for a Chat connection started.



Enable Logging of Communication
This option automatically enables low level communication information for protocol used in 
the connection.



Log to File
This option commits events to a log file for tracking purposes.



Include Time
This option includes the current time.



Include Date
This option includes the current date.



Enable Trace Window
Generates a trace window for tracking events.



Communication
This option allows the communication function.



Change User Preferences           

Click on an area to get more information.



Wait For Incoming Connection on Startup
This option is used to place Remotely Possible/32 in a wait-for-call mode after the application
is started.



Don't Start Automatically
This option means that the user must manually start Remotely Possible/32.



Start Before Logon
This option means that Remotely Possible/32 is automatically started before the user logs 
into Windows.



Start After Logon
This option means that Remotely Possible/32 is automatically started after the user logs into 
Windows.



Don't Hide
This option does not hide application on startup.



Don't Hide - Keep Minimized
This option does not hide application, but minimizes application on startup.



Hide
This option hides the application on startup.



License Number
This is the license number assigned to this PC. Only valid license numbers assigned by 
Avalan Technology, Inc may be entered.



Allow Multiple Instances
This option allows the user to start Remotely Possible/32 more than once on a single PC.



Reboot on Disconnect Minutes
This option allows automatic reboot after disconnect in minutes specified.



Enable Interfaces
Remotely Possible/32 supports multiple protocols based on individual user licenses. This 
selection box allows the user to select which protocols to activate on a particular PC.    When 
a protocol is active the Identification tab will appear under User Preferences and Connect to 
Remote. 



Connect to a Remote  

You may connect via one or all of the interfaces supported in this version of Remotely 
Possible. The interfaces are TCP/IP (via windows sockets), Dial (via Microsoft TAPI, or direct 
connect ports), IPX (Novell Netware), or Netbios (Windows for Workgroups, and others).    
Depending on your version one or all of these tabs may be enabled.    By default the last tab 
you selected will be initially displayed.    To connect using a different interface simply move 
the mouse over the correct tab at the top of the window and press the left mouse button.

Each interface has different options for connecting.    To View each interface press each tab 
in the above picture. 

Pressing one of the buttons at the bottom left of the window will start the connection either 
in Viewer , Chat, File transfer, or Host mode.



Connect using TCP/IP  

 

Press the left button on an area on the following screen to learn more...



Connect using    Dial modems  

 

Press the left button on an area on the following screen to learn more...



How to Connect via Dial Modems  

Connect to a Remote
1 Select Connect button from the Remotely Possible/32 Toolbar.
2 Select the Dial Tab 
3 Connect to Remote Screen is displayed.
4 Select Modem to use from list.
5 Select remote PC to connect to from Address Book or manually fill in fields.
6 Select one of Remotely Possible/32 programs: Viewer Mode, Chat session, File Transfer, or Host mode from the 

toolbar located at the bottom of the Connect to Remote screen.
7 Program is initiated and a connection is established with a remote PC.

Add a New Entry by Manual Selection
1 Select Insert
2 Enter the new name id in the Name box.
3 Enter the new phone number.
4 Enter the Remotely Possible Login Name and Remotely Possible Login Password.
5 Select OK.
6 New entry is recorded in the database.



How To Connect via TCP/IP  

Connect to a Remote
1 Select Connect button from the Remotely Possible/32 Toolbar.
2 Select the TCP/IP tab.
3 Connect to Remote Screen is displayed.
4 Select appropriate address by either manual or by browse entry.
5 Select one of Remotely Possible/32 programs: Viewer Mode, Chat session, File Transfer, or Host mode from the 

toolbar located at the bottom of the Connect to Remote screen.
6 Program is initiated and a connection is established with a remote PC.

Add a New Entry by Manual Selection
1 Select Insert
2 Enter the new name id in the IP Name box.
3 Enter the new IP Address.
4 Enter the Remotely Possible Login Name and Remotely Possible Login Password.
5 Select OK.
6 New entry is recorded in the database.

Add a New Entry by Browse Selection
1 Send out new browse request.
2 Select from Browse results display list
3 Select Copy..
4 Select Insert.
5 Select OK.
6 New entry is recorded in the database.



Main
Displays/changes the currently selected address book.



New
Press here to create a new Address Book. You will be prompted for a name to use to identify 
the address book.



Delete
Press here to delete the currently selected Address Book.    This will erase the file which 
contains the data for the address book.



Current Address Book
This function lists entries in the selected address book. Remotely Possible/32 supports 
unlimited address books.

The Address Book allows you to enter names and addresses of users you frequently call. If 
you are setting up your system to receive incoming calls only, you do not need to use the 
Address Book.

There are separate address books for each interface. The Address Book contains IP 
Addresses (if connecting via TCP/IP), phone numbers (for dial up), IPX addresses (for Novell 
IPX) , Netbios names (for Netbios) and Remotely Possible/32 Login information for 
connecting to remote systems. The Address Book is for outgoing connections only.



Number of Entries



IP Name
The IP name of the remote system. This field is filled in by selecting an address book entry, a
browse entry, or by manually typing in the desired address. You may also optionally enter 
the IP address assigned to the remote PC.



IP Address
This is the IP address of the remote system. This field is filled in by selecting an address 
book entry, a browse entry, or by manually typing in the desired address. You may also 
optionally enter the IP name assigned to the remote PC.



Browse Net
This option allows you to browse the network.



Networks To Browse
This function sends out a broadcast to all Network numbers that are listed in the Networks to
Browse Address Book.    You can add a new Network number to browse on. With Remotely 
Possible/32, you can have multiple network numbers to browse.



Note
The Networks To Browse function is useful in Router Configuration environments.



Browse Results
This displays the results of browsing the network.



New
Adds a Network number.



Delete
Deletes a Network number.



Copy
This copies the currently selected address to the default address book. This button is active 
when browsing the network.



Insert
Adds a new entry to the address book.



Delete
Deletes the selected entry from the address book.



Change
Changes the selected entry in the address book.



Always Browse
This function allows automatic browsing.



Listen for Incoming Calls  

This function initiates a Wait for a Call Mode from a PC, so that another PC running Remotely 
Possible can connect to it.

The Listen For a Call window is displayed if the Trace option is selected from the Change 
User Preferences Event Log. The information in the Trace window such as date, time, and 
listening status is also controlled by selections made in the Event Log. If unselected, a 
blinking message is displayed on the status bar.



Normal  

When a connection is in progress or currently established, this option prompts the user to 
disconnect the remote user.



Reboot Remote  

When a connection is in progress or currently established, this option forces the Host PC to 
reboot immediately.    If you need to reconnect to the Host PC make sure that both Windows 
and Remotely Possible/32 Host start up automatically after booting.



Restart Windows  

When a connection is in progress or currently established, this option forces Windows to 
restart. This option is useful when changing a Windows system file and you want the change 
to take effect immediately. You should manually close all applications prior to invoking this 
command remotely.



Disconnect All  

When multiple connections are in progress or currently established, this option ends all 
connections without you having to select a disconnect from each connection.



Disconnect
This disconnect button is for one station at a time.



Using Viewer Mode
Select this option if you will be remotely controlling another PC on your network.



Using Host Mode
Select this option if you will be remotely controlled by another PC on your network.



Using Remote Control       

 

When using Remote Control, the Viewer is the PC that remotely controls the Host PC.

The example below demonstrates how a single PC can view two or more PCs.    Fred and 
Barney are acting as Host PCs and are being controlled by a single Viewer



List of Connections
This list box displays the active connections with this PC. To switch between connections 
simply select a connection from the list box.



Local Cursor
When the Viewer is in monitor only mode the local cursor is disabled from controlling the 
remote PC. When disabled the cursor will appear in a circle with a line through it. 

See also Ghost Cursor



Ghost Cursor
When the Viewer is in monitor only mode, the Host’s cursor will appear grayed out so the 
user can distinguish between the local and remote cursors.

See also Local Cursor



Active Session Window
The title of the Window indicates the current remote window with the input focus.



How To Run Remote Control  

Use Remote Control
1 For Host mode, select Wait For a Call.
2 For Viewer mode, select the Viewer icon located at the bottom of the Connect to Remote window.
3 If you are already using a Remotely Possible/32 program, you can switch to Remote Control by selecting either 

the Viewer or Host icon located at the bottom of the Connect to Remote window.
4 This action simultaneously produces host and viewer screens for remote control.



Using Chat Session  

To Use Chat
n Start Chat on connect by selecting the Chat Icon located at the bottom of the 

Connect to Remote screen or from the Connection Toolbar if already 
connected.

n This action simultaneously produces a Chat window on the Host and a Chat 
window on the Viewer displays, which are independent, resizable, and 
moveable.

n Move the insertion point to the upper window and begin typing.
n Data is transmitted to the remote PC and displayed in the remote PC’s lower 

window.
n Remote PC user moves the insertion point to the upper window and responds 

by typing information.
n Data is transmitted back to you as the originator and appears in your lower 

window.

To Copy Information Between Chat Windows
n Select the information from the remote Chat (lower) window.
n Select the Copy command.
n Move the insertion point to the originator Chat (upper) window.
n Select the Paste command.
n Copied Information appears in the originator Chat window.



How To Run a Chat Session  

To Use Chat
1 Move the insertion point to the upper window and begin typing.
2 Data is transmitted to the remote PC and displayed in the remote PC’s lower window.
3 Remote PC user moves the insertion point to the upper window and responds by typing information.
4 Data is transmitted back to you as the originator and appears in your lower window.

To Copy Information Between Chat Windows
1 Select the information from the remote Chat (lower) window.
2 Select the Copy command.
3 Move the insertion point to the originator Chat (upper) window.
4 Select the Paste command.
5 Copied Information appears in the originator Chat window.



Using File Transfer                

 



Create Directory
Creates a directory for the Local or Remote PC.



Remove Directory
Removes a directory from the local or remote PC.



File Transfer Status Bar
Provides a brief status and includes the background or foreground PC during the file transfer.



How To Run File Transfer  

To Use File Transfer
1 Select File Transfer from the Switch menu.
2 Or select from the icons on the Connection Toolbar located at the bottom of the Connect to Remote window.
3 This action simultaneously produces a FileTransfer window on the Host and a FileTransfer window on the 

Viewer displays, which are independent, resizable, and moveable.
4 You send or receive files by selecting the particular files and then selecting Start Transfer.



Local File
Input field to specify a file filter for the list of local files displayed. Entering the *.* wildcard 
function displays all local files in the current directory.



Local Path
This control specifies the local directory path. Double-clicking on the .. function moves you 
up one directory at a time.    To get to a particular directory, find and double-click on that 
directory within this local path.



Search
The Search command button finds the file(s) specified in the local file input field.    You can 
also use the *.* wildcard function to enter as part of the filename if you are not certain of a 
filename.    



Select All
The Select All command button selects all the files in the current directory in one step.



Remote File
Input field to specify a file filter for the list of remote files displayed. Entering the *.* wildcard
function displays all remote files in the current directory.



Remote Path
This control specifies the remote directory path. Double-clicking on the .. function moves you
up one directory at a time.    To get to a particular directory, find and double-click on that 
directory within this remote path.



Files in Queue
Displays the files queued for file transfer. To initiate the transfer select the Start Transfer 
button.



Send
This command adds the currently selected local files to the queued files list for file transfer 
from the local PC to the remote PC. In the Files in Queue list box, the send transfer is 
indicated by the directional arrows -->-->--> that point towards the remote PC direction of 
the send transfer.

If the Select All command was used to select all the files in the current directory, the Send 
command sends all the directory files to the queued files for file transfer.



Receive
This command adds the currently selected local files to the queued files list for file transfer 
from the remote PC to the local PC. In the Files in Queue list box, the receive transfer is 
indicated by the directional arrows <--<--<-- that point towards the local PC direction of the 
receive transfer.



Remove
This button removes the currently selected file from the queued files list.    If you select all 
the files in the queued list, this button removes all of them.



Remove All
This button removes all the currently selected files from the queued files list.



Start Transfer
This button initiates the file transfer of all the files in the queued files list.    The file transfer 
can be send or receive files from the connected PCs.



Cancel
This button cancels the current file transfer and returns to the normal File Transfer window.



Options  

This button selects file synchronization and user confirmation options.



Freshen And Copy New Files
Combination of Freshen existing files and Copy new files options only. You may also 
select both Freshen and Copy new files together. This option will only transfer files that 
are newer or didn't previously exist in the destination directory.



Leave Filtered Files in Queue
If a file is not transferred for any reason the file remains in the files list to allow you to 
change the destination name or to correct a problem on the destination system. 

However you may also have Remotely Possible/32 remove any file from the queued file list 
even if it has not been sent. Select the Remove filtered files from queue option. This will 
cause any filtered files to be removed from the list when not sent. We recommend that you 
leave this setting alone to see which files have been sent and that have not been sent. 
Otherwise you will have to check the destination directories to determine which files were 
transmitted.



No Confirmation
All files are transferred without any user confirmation. Existing files are overwritten with new
files.



Confirm on Replace Only
A confirmation message is displayed before overwriting any existing files.



Confirm All Files
You may have Remotely Possible/32 prompt you before replacing any file by selecting 
Confirm on replace only, or before each transmission by selecting Confirm all files.
A confirmation message is displayed before transferring each file, whether it is being 
replaced or not.



Transfer All Files
All files in the queued files list are transferred from the source to the destination.



Freshen Existing Files Only
Only newer files are transferred. If the source file has a newer date than the destination file 
it is transferred. If the source file is older than the destination file or if it doesn't exist on the 
destination it is not transferred. You may also direct Remotely Possible/32 to Freshen 
existing files only, which will only transfer files that have a later date or time.



Copy New Files Only
Only files that do not exist on the destination system are transferred. If a file exists on the 
destination it is not transferred. It can also Copy new files only, which will not replace any 
existing file with the same name but will only add new files to the destination's directory.



Refresh
Updates the file entries to show new files, dates, times, and deletions.



Rename File
This is the file rename window. You may enter a valid path on the destination system. If the 
pathname is not valid you will receive an error when the file transfer is attempted. After 
entering a new name press OK or press Cancel to keep the current destination name.

Enter the new file name here.    The file will be renamed to this name after copying the file. 
You should enter the full pathname of the file, not just the file name.



Remaining Files
Displays the files waiting to be transferred.



Current Files Remaining
Displays the number of bytes remaining in the current file being transferred.



Current File Speed
Displays the average speed of the file being transferred in characters per second (cps).



Current File Time Left
Displays the current time left for the file.



Current Files Percent Complete
Displays the percentage of the file that has been transferred.



Current Files File Size
Displays the file size of the file being transferred



Current Files File Speed
Displays the speed of the file being transferred



Total Files Remaining
Displays the number of bytes remaining in the files remaining to be sent.



Total Files Time Left
Displays the current time left for the total files.



File Transfer Queue
Listing of current files to be transferred by send or receive mode.



Total Files Percent Complete
Displays the percentage of the total files transferred.



Total Files File Size
Displays the file size of all the files being transferred



Total Files Speed
Displays the average speed of the all files being transferred in characters per second (cps).



Pause
This button pauses the file transfer until the Resume button is selected.



Resume
This button continues the file transfer from the prior Pause stage.



Delete Entry
Remove the currently selected entry from the remaining files list



Remaining Files List Box
The Remaining Files list box displays the files remaining to be sent or received. In the 
example above we are sending files to a remote PC. When active, only the Pause button 
may be selected. Once paused you may Resume transmission, Delete Entry from the list 
of remaining files, change the current file transfer Options... or Exit back to the main File 
Transfer screen. Any files remaining in the list will be removed from the list when you Exit 
back to the main screen. When paused you may also change the destination name of a file 
in the list.



Toolbar  

You can use the toolbar for quick access to commonly used commands. When you first start 
Remotely Possible/32, the Standard Toolbar is displayed. After you establish a connection 
with another PC running Remotely Possible/32, the Connection Toolbar is displayed.

Standard Toolbar
This toolbar displays the five basic program functions - Edit Access Code, Edit User 
Preferences, Allow incoming calls, Connect to remote, and Help.

Connection Toolbar
This toolbar is available after a successful remote connection is made.    This toolbar allows 
you to switch between the different session options Chat, File Transfer, Host Mode or Viewer 
Mode, without having to close the last session type.

You can display or hide these toolbars as you work.    For example, when you select Toolbar 
from the View Menu, a  is placed beside your selection meaning the toolbar is visible.    To 
hide the toolbar, repeat the steps and the    disappears.



Switch To Full Screen
Enlarges the Host screen from a window on the Viewer PC to a full screen.



Status Bar  

The status bar located a the bottom of the Remotely Possible/32 window provides 
information about the active program or task that you are currently working on.
You can display or hide the status bar as you work.    For example, when you select Status 
Bar from the View Menu, a    is placed beside your selection meaning the status bar is 
visible.    To hide the status bar, repeat the steps and the    disappears.

Status Bar Example



Keep Visible  

The Keep Visible button resembles a push pin on the Connection Toolbar or may be 
selected from the Main Menu - Window option. This option is used when a user is connected 
to more than PC and wants to view multiple connections simultaneously.    If the push pin is 
in the sessions for the selected connection will remain visible should the user switch to 
another connection.    There is no limit to the number of connections that can be selected 
and the push pin can be independently toggled on or off for all active connections..



Keep Visible
The Keep Visible button resembles a push pin on the Connection Toolbar or may be 
selected from the Main Menu - Window option. This option is used when a user is connected 
to more than PC and wants to view multiple connections simultaneously.    If the push pin is 
in the sessions for the selected connection will remain visible should the user switch to 
another connection.    There is no limit to the number of connections that can be selected 
and the push pin can be independently toggled on or off for all active connections..



Cascade  

The Cascade command located on the Window menu causes the windows to overlap so 
that each so that each title bar is visible.

Cascade Example



Arrange Icons  

The Arrange Icons command located on the Window menu causes the scattered number 
of application icons across your PC to become arranged evenly.



Tile Horizontally  

The Tile Horizontally command located on the Window menu arranges the open windows 
in smaller sizes to fit next to each other in horizontal arrangement.

Tile Horizontally Example



Tile Vertically  

The Tile Vertically command located on the Window menu arranges the open windows in 
smaller sizes to fit next to each other in a vertical arrangement.

Tile Vertically Example



Common Problems  

This section describes the most common problems that may occur during the operation of 
Remotely Possible/32.

Colors do not match the Host
Solution: 

· When you run a different number of colors on the Host and Viewer, the colors are 
converted by the video driver to whatever is closest on the color palette.    This 
may cause some color distortion.    If you do not want the colors to be mapped, 
run the same number of colors on both the Host and Viewer.

Fatal Exception 0D during Windows 95 boot
Solution:    

· Remove any other remote control programs from the PC before installing 
Remotely Possible.    (Ex. Reachout, PCAnywhere )

Performance
Solution: (TCP/IP)

· Enable Data Compression over a Dialup PPP connection. Under the Change User 
Preferences - TCP/IP Identification Tab. 

· Do not use Error Correction unless you have a poor TCP/IP connection.    
· Disable the Host Wallpaper by selecting Change User Preferences - Viewer or Host

Identification tab.    
· Lower the number of colors used    to 256 or 16.

Solution: (Dial)
· Enable both Data Compression and Error Correction.
· Disable the Host Wallpaper by selecting Change User Preferences - Viewer or Host

Identification tab.
· When connecting to Remotely Possible/Dial 16 bit version, turn off Data 

Compression.
· Use a higher speed modem.    A 28.8k modem will give the best performance.

Performance during Microsoft Word for Windows 6.x and 7.x.
When Microsoft Word is set to View - Page Layout, you may experience a delay during a Dial 
connection when typing.    To increase the performance in this area use the following 
guidelines:

·  Select View - Normal
·  Begin typing until you see an increase in performance
·  Select View - Page Layout
·  Typing should resume at the previous speed

When controlling Word 6.x or 7.x with a 16-bit Viewer you may experience slow typing 
responses during dial connections.    For optimum performance you should use Remotely 
Possible/32 running on Windows 95 as your Viewer .



Error Messages  

Error, unable to connect to remote PC. <Additional error information>
Please refer to the error code that is displayed in the <Additional error information>.

Error, duplicate license number detected.
A duplicate license number has been detected on your network.    Please make sure each PC 
running Remotely Possible/32 has a unique license number.    If you need additional license 
numbers, contact your Avalan Sales Representative for details.
 
Error unable to open connection.    Recheck destination address.
Solution (TCP/IP):
Be sure you have the TCP/IP installed and configured properly on your PC. 
Check to see if you can ping the address you are trying to connect to.    
If you are not using DNS, setup a HOSTS table.

Incorrect Login Name.
Solution: Recheck the RP Login Name and RP Login Password in the Connect to Remote 
screen.    Make sure there is an appropriate entry in the Edit Access Codes, on the PC you are
trying to connect to.

Sending connect request via timer.
Solution: Make sure the PC you are calling is Listening for a Call.    This message is displayed 
when the remote PC is not responding to the connect request.

Timed out waiting for response.
Solution: The remote PC did not respond to the connection request.    Make sure the PC you 
are calling is Listening for a Call.    If you are running TCP/IP, try to PING the address that is 
not responding.

Unable to View remote PC.    Remote Host is not Enabled.
Solution: Select Change User Preferences, Choose the Host Identification Tab, Check the box 
Enable Host operation and reboot your PC.

You have not enabled any interface for incoming calls. Select Allow Incoming Calls
when configuring the interface.
Solution: Select Change User Preferences, Choose the Protocol Identification Tab you want to
communicate with TCP/IP, Dial, IPX or Netbios.    Check the box Allow incoming calls, or if 
using Dial - Select the modem for incoming call(s).



Software Compatibility  

Performance during Microsoft Word for Windows 6.x and 7.x.
When Microsoft Word is set to View - Page Layout, you may experience a delay during a Dial 
connection when typing.    To increase the performance in this area use the following 
guidelines:

·  Select View - Normal
·  Begin typing until you see an increase in performance
·  Select View - Page Layout
·  Typing should resume at the previous speed

When controlling Word 6.x or 7.x with a 16-bit Viewer you may experience slow typing 
responses during dial connections. For optimum performance you should use Remotely 
Possible/32 running on Windows 95 as your Viewer.

16-bit TCP/IP Stacks.
We have seen problems using a 16-bit TCP/IP stack with 32-bit TCP/IP applications which use 
Windows Sockets.    We strongly recommend using a TCP/IP stack designed for 32-bit 
versions of Windows. 



Note
When you press Cancel, all previous changes, additions, and deletions are preserved. Only 
the current selection(s) are not saved.



Multi-tasking
Includes multiple Host and/or multiple viewer support.    You can support multiple hosts from 
a single Viewer, and multiple Viewers from a single Host.

Examples of uses include a Help Desk organization, support and service functions, training 
and classroom instructions.



Scripting
Provides a simple means to automate sessions. You can automate your PCs to perform 
dialing, session connects, and    file transfers from long distances.

Example of scripting is for your PC to collect data from several PCs at a scheduled time, and 
redistribute the new data to waiting PCs.



Full Compatibility with 16 Bit Windows
Provided during remote control, file transfer, remote printing, and interactive chat sessions.



Enhanced Performance
n Provides 32 bit multi-tasking capabilities in the operating system
n Provides long filename support
n Provides 32 bit color support



New Drag and Drop Support
Provides easy to use file transfers.



Simultaneous Control of Multiple Protocols
Provides remote control simultaneously across TCP/IP, IPX, Netbios, and modem connections.



Windows Online Help
Provides context-sensitive help to resolve problems and access information immediately 
within the Remotely Possible/32 program, and also as an on-line reference tool before using 
the Remotely Possible/32 programs.

You can access context-sensitive Help by selecting the Help button for the specific dialog 
box or window within Remotely Possible/32.    You can access On-line Help to learn about 
Remotely Possible /32 before using the program by selecting the Help button from the 
Remotely Possible/32 main window.



Security
n Provides multi-level passwords
n Provides callback to a programmed address
n Provides optional logins
n Provides multiple access levels to prevent unauthorized access
n Provides keyboard, mouse, and screen disabling



Access Codes
Access Codes allow you to define who has access to your PC, and are intended for incoming 
connections to your PC. Access Codes maintain a database of passwords and user names 
that authorize access. With Access Codes, you can limit access to your PC to certain users, 
and also limit access to certain functions such as receive files only or remote control only. 

The Access Codes function is the heart of the security system within Remotely Possible/32. If
you are setting up your system to place outgoing calls only, you do not need to use the 
Access Codes function. You can assign access levels for your PC on a per-user basis. For 
example, you can allow all users Chat access, some users access to remote control, and limit
file transfer to send only. You may also enable call-back security, which lets you enter an IP 
Address for your PC to call back.    A    caller must be at the callback address when 
connecting.



Welcome to Remotely Possible/32

Thank You for Purchasing Remotely Possible/32

Remotely Possible/32 is Avalan Technology’s exciting new multiprotocol version that 
provides 32 bit support of Microsoft’s Windows 95 and Windows NT networks.

Remotely Possible/32 is a powerful yet easy to use remote communication software 
package. With Remotely Possible/32 you are able to remotely control another Windows PC, 
or exchange files, and have an interactive chat session with a remote user on another 
Windows PC.

Remotely Possible/32 operates over all types of TCP/IP connections, including SLIP and PPP. 
Since Remotely Possible/32 interfaces to TCP/IP via the Windows Sockets API, the underlying 
physical connection is transparent to Remotely Possible/32.

AVALAN
TECHNOLOGY



Note
The user can even change this file so make sure to password protect your database.



Technical Support  

AVALAN Technology, Inc.
P.O. Box 6888

Holliston, MA    01746-6888

    508-429-6482

    508-429-3179

    tsupport@avalan.com

    8:30-6:30 EST Monday - Friday



Note
You cannot type into the lower window, because it is an output window only.    However, you 
can copy and paste information from this window whenever necessary.



Drag and Drop File Transfer
Drag and Drop File Transfer allows a user drag files from the desktop or other applications 
and drop them into the RP/32 File Transfer window. This automatically adds file to the list of 
files to send to the remote user.



Event log



Apply
The Apply button is functional only when it is highlighted. When this button is grayed out as
is currently, it means that it is not implemented at this time.



Note
Use the Don't flash Host screen option with care since this increases the time it takes to 
transmit the initial Host screen to the Viewer.



Easy Installation
Easy-to-use installation for fast setup and startup. The installation is contained on one disk.



Simultaneous Local and Remote Printing
Simultaneous printing for both the Viewer and Host PCs.



Host Confirm Connect
A confirmation of the Host PC on connection during Remote Control.



Note
Replacing files in Remotely Possible/32 includes a safety feature to protect against file loss.



Taskbar  

You can use the taskbar for quick access to PC-sharing of information especially used in 
training sessions. Baton passing is a feature that passes PC information control among 
several PCs running simultaneously.



How To Edit the Access Codes  

To edit Access Codes:
1 Select Access Codes from either the File menu or Standard toolbar located on the Remotely Possible/32 Main 

menu.
2 Edit Access Codes password screen appears.
3 Enter the correct password and select OK.
4 Edit Access Codes screen appears.
5 Select or enter the appropriate information on this screen.    For example, to enter a new user, select Add to 

clear the dialog box, and then enter the new user information and select Add to record it into the database. Or,
select from the user Access List and make the appropriate entries.    Select OK when completed.

6 Security Options Dialog box is included to add for more security features.    To access this dialog box, select the
Security button at the bottom of the Edit Access Codes window.

7 To get help on any of these fields, press the Help button.



How To Change User Preferences  

To change User Preferences:
1 Select User Preferences from either the File menu or Standard toolbar located on the Remotely Possible/32 

Main menu.
2 You can modify different areas within this selection:

n Viewer mode
n Host mode
n TCP/IP (if included in product)
n Dial Modems (if included in product)
n Event log
n General

1 By choosing a tab for one of the selections at the top of the User Preference window, you can change any of 
the previous user preference settings.

2 After you make the changes, select OK to save the changes. For each of the selections that you complete, 
select OK to save these changes.

3 To get help on any of these fields, press the Help button.



How To Run Remote Control  

To run Remote Control:
1 For Host mode, select Wait For a Call.
2 For Viewer mode, select the Viewer icon located at the bottom of the Connect to Remote window.
3 If you are already using a Remotely Possible/32 program, you can switch to Remote Control by selecting either 

the Viewer or Host icon located at the bottom of the Connect to Remote window.
4 This action simultaneously produces host and viewer screens for remote control.
5 To get help on any of these fields, press the Help button.



Map Viewer redirected printer ports
When the Viewer is redirecting a printer port it selects the port using ports LPT1 through 
LPT4. When the Host prints it does not always use ports. This field will map the port the 
Viewer is redirecting to a Host printer. You may either select a locally attached printer or a 
network printer. 



Port
The TCP/IP port Remotely Possible uses to communicate.    This value must be the same as 
set in the remote PC you will be connecting with.



Connect as a Viewer
Press this to connect as a Viewer. You must first select the destination address of the Host 
PC before pressing this button.



Connect as a Host
Press this to connect as a Host. You must first select the destination address of the Viewer 
PC before pressing this button.



Connect in Chat Mode
Press this to connect in Chat mode. You must first select the destination address of the 
remote PC before pressing this button.



Connect in File Transfer Mode
Press this to start the connection in File Transfer Mode. You must first select the destination 
address of the remote PC before pressing this button.



Delete Entry
Removes the currently selected entry from the Address Book



Program Files
RP32.HLP Help File
RP32.EXE Remotely Possible/32 Main Program
PASSWORD.EXE Remotely Possible/32 Security Administration Utility
RESTART.EXE Remotely Possible/32 Restart Windows Utility
RP32COMM.DLL Communications Dynamic Link Library
VIDEO32.DLL Host Remote Control Dynamic Link Library 
RP32.VXD Host Remote Control Virtual Device Driver
HATTEN.TTF Font File
DIALOG.FON Font File
RP32.LOG Log File (created by Remotely Possible)
README.TXT Application Notes
RP32PASS.DAT Password File
*.SAB TCP/IP Address Book(s)
*.DAB Dial Address Book (s)
*.IAB IPX Address Book (s)
*.NAB NetBios Address Book(s)



Baton Passing
Baton Passing - This feature is applicable in a Classroom or Interactive Demonstration 
environment where a single Host PC has two or more Viewer PCs running remote control 
sessions.    The Host PC acts as the Chairman and can grant or revoke a Viewers 
participation.    This Host only feature is known as “Baton Passing”.    When Remotely Possible
is started the RP logo Icon is displayed in the Windows 95 Task Bar.    Using the Right Mouse 
Button, click the Icon and a menu appears. The Enable/Disable Student Keyboard option is 
only available when two or more Viewers are connected to the same Host.    Select 
Enable/Disable Student Keyboard and the Host User can allow All Viewers/ No Viewers/ 
Selected Viewer ability to control the Host.



TCP/IP Address
The TCP/IP connection tab lets you type in the IP name and IP address of a Remotely Possible
computer on a TCP/IP network.    If you are using a network that filters out the broadcast from
the Browse Net option, you’ll want to save the IP name and address in one of your personal 
address books.    To access this information select the Connect to Remote Icon.



How To Connect using Icons  

Connect to a remote client quickly and easily by selecting a predefined icon.    This 
short-cut method eliminates the need to connect using the Graphical User Interface.

To create an Icon to use for dialing:

1 Create an Address book entry for the remote PC if you haven’t already.
2 Create a ShortCut to the RP32.EXE file.
3 Change the properties of the new ShortCut Icon.    Select the Shortcut tab, then go to the Target section and 

add the Address book name to the end of the line. (Note:    If you are using long names, the Address book 
name must be outside the ending quotes.)

Example.

“C:\Program Files\Avalan\Remotely Possible\RP32.exe” FRED
or
C:\WIN95\RP32\RP32.exe FRED



Long File Names
Windows 95 and NT support file names that are greater than the 8.3 DOS 

naming convention.    If the user connects to another Windows PC that supports Long File 
Names, File Transfer will use and display the long file name. If the    user connects to a 
Windows 3.x PC, File Transfer will use and display the short file name.



Communications Port
Select the device on which to place the outgoing call.    You may select a 
modem to use or a direct connect port 



Configure Port
This will configure the port selected in the list box below.    For direct connect ports you may 
change the port speed.    For TAPI devices the options you may change vary with the device.



Name
The name of the remote PC.    This is used for informational purposes only when using dial-up
modems or direct connect ports.



Phone Number
Enter the phone number of the system you are calling.



Connect using IPX
IPX support is not currently available.



Connect using Netbios
Netbios support is not currently available.



Listen for a connection
Select this button to enable this PC to listen for an incoming call or connection.




